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1 Important and general information IP=TRONIK

1 Important and general information

1.1 Important information

Please follow these instructions before and during the use and application on any IPETRONIK product!

1.1.1 Safety and Warning instructions

Please follow the instructions and information as contained in the user manual!

1. The user can influence an electronic system by applying the IPETRONIK product. This might cause
risk of personal injury or property damages.

2. The use and application of the IPETRONIK product is permitted only to qualified professional
staff, as well as, only in appropriate manner and in the designated use.

3. Before using an IPETRONIK measurement system in the vehicle it has to be verified that no function
of the vehicle, which is relevant for secure operation, might be influenced:
- by the installation of the IPETRONIK measurement system in the vehicle,
- by an potential malfunction of the IPETRONIK system during the test drive.

In order to avoid possible danger or personal injury and property damages, appropriate actions are to be
taken; such actions have to bring the entire system into a secured condition (e.g. by using a system for
emergency stop, an emergency operation, monitoring of critical values).

Please check the following points to avoid errors:

- Adaption of sensors to components of the electrical system / electronics, brake system, engine and
transmission control, chassis, body.

- Tap of one or several bus systems (CAN, LIN, ETHERNET) including the required electrical
connection(s) for data acquisition.

- Communication with the vehicle’s control units (ECUs), especially with such of the brake system and/or
of the engine and transmission control (power train control system).

- Installation of components for remote data transmission (mobiles, GSM/GPRS modems, WiFi and
Bluetooth components).

The products can be operated in extended temperature ranges greater 70 °C and therefore the ope-
rator has to take safety measures to avoid any skin burnings on hot surfaces while touching the
products.

4. Before directly or indirectly using the data acquired by an IPETRONIK measurement system to cali-
brate control units, please review the data regarding to plausibility.

5. With regard to the application of IPETRONIK products in vehicles during use on public roads the manu-
facturer and/or registered user of the vehicle has to ensure that all changes/modifications have no
influence concerning the license of the vehicle or its license of operation.

6. User does agree to the instructions and regulations as mentioned above. In case the user does
not agree with the instructions and regulations as mentioned above, he has to notify this expressly and
immediately in writing to IPETRONIK before confirming the sales contract.
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1.2 Terms and conditions IP=TRONIK

1.2 Terms and conditions
See IPETRONIK website for details: https://www.ipetronik.com/

1.2.1 Legend of used icons

This icon indicates a useful tip that facilitates the application of

Tip the software.
, This icon indicates additional information for a better understan-
6 Information ding
. This icon indicates important information to avoid potential error
A Attention!
messages.

1.2.2 Support

Headquarter:

IPETRONIK GmbH & Co. KG

Im Rollfeld 28

76532 Baden-Baden, Germany

Phone +49 7221 9922 0

Fax +49 7221 9922 100

info@ipetronik.com

www.ipetronik.com

Limited commercial partnership with its head office in Baden-Baden, registry court HRA No. 201313
IPETRONIK Verwaltungs-GmbH Baden-Baden is an individually liable society, registry court Mannheim HRB
No. 202089

CEOs: A. Wocke, C. Buchholz

Technical support and product information
www.ipetronik.com e-mail: support@ipetronik.com
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2 Plugin Overview IP=TRONIK

2 Plugin Overview

2.1 Plugln description

With the Ni-DAQmx Plugin you have access to a selected number USB cards from the DAQmx series from
Nations Instruments.

2.2 Plugin installation

The NI-DAQmx Plugin is hosted on the IPETRONIK website www.ipetronik.com. After having installed the Plu-
gln, you need to restart IPEmotion. A message window will notify you, telling that a new Plugin was found. After
activation, the Plugin can be used for data acquisition. The Plugins are managed in the options of IPEmotion.

 IaliE 2B X

FES Activate Plugin in OPTIONS NI
(] # IPEmotion options x
Eb Save as
Fr itfy ugad
- o Active Tite Version Description -
i Basic setfings
@I—? App-Export » = A ADDIDATA D1.00.00. 14530 ADDI-DATA Ethernet Devices
v Appearance
o i B sovanTEcH 01.00.00. 27451 RE ADVANTECH bus coupler
@ Runtime version = B BEOMHORF 01.02.00 BECKHOFF Bus Coupler
Data manager
i Tt B, CAN-Send 01.00.01 CAN-Send with IPETRONIK CAN server
Py
|— Compare . Gl CAN-Acquisiton 01.05.00 CAN-Acquisition with PETRONIK CAN Ser, .
== wport o
LML 01.03.00. 14870 Serial interface for GPS mouse
|: Analyss "
‘E‘ Print » Maps Comecting NI DA devices ()
= Drsctories ULUL00 Access to process data of Semens P
\», View » Uinits il wdeo 01.00.04.28250 Synchronic recarding of video data'for ca...
L B 1 i
F =] 01.01.00.31508 RC WAGO Bus coupler
‘Q PR User admiristration h_ CAN protocals 010103 CAN protoool acquisition yith any CAN hai.. |
PEcioud
Showifedit generll IPEN User displays =
] ———— Uiser operations m
e About Specy he pugns o b e,
_o The used plugin version can be changed within the list. If & version number iz selected that ends with a ‘=" character, no
Butomatc update i run at installng later plugin versions. -
Close
0K Cancel

The Plugln is supporting the following Windows operating systems:

» 32 bit
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2.3 NI-DAQmXx driver installation IP=TRONIK

2.3 NI-DAQmx driver installation

The Ni-DAQmx Plugin requires the NI-DAQmx driver library from national instruments. This library needs to be
installed so that the devices are recognized correctly over the USB interface. The latest driver is hosted on the
NI website. The NI-DAQmx device driver should be selected for the installation.

[ 38 ra-Daqmass = B
|
| m quisiiy;
NI-DAQ'mx 9.6
TreiberSoftwany™ | 52 I
45 NI-DAQmx 9.6 =
&;;i‘;"mgﬂ W'a'l'llllen Si.e eline Inslallaliunxoglim MATIONAL I
Dalei readme_daut ‘wahlen Sie eine der folgenden Optionen. INSTRUMENTS"
National I
2 2003-2012 Mati
L x @ Empfohlen - : L]
B~ Installation von NI-DAGme-G eratetreibemn, Unterstutzung fur Hardwarekonfiguration und |
| 'l_ifE,F- “Ertwick LIng wor ﬁpﬂﬁanmen.
=
) Benutzerdefiniert
=W ahlen Sie die zu instalierenden Komponenten aus.
(o
-t O
<<Zuiick |[ Weiter>> || Abbrechen |
L )

[2_NI]

After the installation and the connection of the device to the computer the hardware is directly recognized in
the “Devices and Printer” menu.
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2.3 NI-DAQmXx driver installation IP=TRONIK

. e e ———
] |@ » Systemsteuerung b Hardware und Sound

Datei Bearbeiten | Ansicht  Edras ?

Gerat hinzuflgen Drucker hinzufdgen

4 Drucker und Faxgerate (7)

Canon MG5300 Fax HP LaserJet 3390
series Printer /3392 PCLS

4 Gerate (3)

D7

i [T02-0203 Optical USB PL2409HD
i Mouse

' Nicht angegeben (2)

—— —
oy L
USB-6221 (BNC) ~ USB-6229 (BNC) [3_NI]
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3 Plugln configurtion IP=TRONIK

3 Plugln configurtion

3.1 Hardware detection

IPEmotion has functions for automatic hardware detection. For USB devices like from the NI-DAQmx family it is
for users very comfortable to use the automatic hardware detection to set up a communication with the board.

AUTO : 9% ii r‘ L ﬁ E %

File Project Signals Acquisition View Data manager Analysis Reporting g

NN B $ T 0EAs®E &

Check Adjust | Detect | [nitialize Display | Details CSV-Importer

V01.01.00 Detect
Name Z Create a new hardware configuration with the connected
devices. This function does not only apply to the modules shown
in systems, but to all found hardware of all connected hardware
— | systems.
|| _us
>} 16 Devifportifiine2 v 0,00
@ 2 Dev1/portifine3 v 0,00
% g Dev1/portifine4 v 0,00
Analog Out 2 -
Dev1/port1flines v 0,00
YD, Digital (Hardware-Timed) 8
Dev1/port1flines v 0,00
+ Nl usB-6229 (BNC) - 2 78
m Digital 16 Dev1jportifline? v 0,00
@ Counter 2 Dev 1/port2fline0 v 0,00
Y4, Analogin 24 Dev1/port2fiine1 v 0,00
YA, AnalogOut 4 Dev1/port2fiine2 v 0,00
Y0, Digital (Hardware-Timed) 32 Dev1/port2fiine3 v 0,00

[4]

In this example 2 USB device are connected to the computer. After the detection both systems with the
complete channel overview are created. All the channels are grouped on signal type. On device level in the
Extended tab sheet the device serial number is indicated.

o In e 1 3 B
Project Signaks Acquisition View Data manager Analysis R
| L1+ O i &
N+ B ¢ T 2m # > ®» B B
System X Check Adjust petect Initialize Display | Details CSV-Impor
V01.01.00 Name Active | Unit
Name 21 .
»  Devlfportlflined v
fﬂl Dev1l/portifinel v
16 Devl/portlfine2 v
@ Counter z Dev1/port1fine3 v
% Analog In 8 Devifport1fine4 =
Analog Out 2 )
De t 5 v
0  Digital (Hardware Timed) 8 i
4 NI USB-6223 (BNC) - 2 78 Generall  Extended | Information
g Digital 16 Bus type:
Counter 2 B .
A = = Serial number: | 13D0BE4 h
Y  Analog Out 4 Il
0, Digital (Hardware Timed) 32
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4 Device 6501 IP=TRONIK

4 Device 6501

4.1 Device Overview

» 24 x digital I/O lines

» 1 x 32-bit counter

4.2 Digital Inputs / Outputs

~ 0 5 EENEET TR

Project Signals ACquisitio View Data manager Analysss Reporting Scripting
= = o \
I E () ‘Q
Nl N & TOBEAS®
NI DAQmXx System Check Adjust Detect Iniialize Display | Details CSV-Importer
VO1.01.00 Name m»% Uniit PhysMin  PhysMax T SensorMin  SensorMax  Samping rate
Mame Z L ]
1-portidfined " 0 1 0 1 10 Hz
N umesr- > SN - I O O R
il 1-portd fine2 0 1 0 1 10 Hz
©  Counter 1 i-portd fine3 0 1 0 1 10Hz
1-portd fine4 [4] 1 0 1 10 Hz
1-portd fines 0 1 0 1 10 Hz
1-portd fines 0 1 0 1 10 Hz
1-portd dine 7 0 1 0 1 10 Hz
General = Format  Scaling  Display
Active: v
Name: | 1-portDfiinel
Desaiption:  Digital-1/O channel
Reference:

[7]

The digital in- and outputs are software timed channels, i.e. the data is periodically sampled by using a
software timer. Analogue to the software timed counter, only sampling rates are accepted, which can be
converted into an even period duration (1000/Sampling rate).

» The same sample rate configured for one channel is automatically applied to all other digital inputs.
Define Data direction:

» The Format tab defines the channel type as an in- or output. Over this configuration it is defined whether
the channel is operated as an input or output

Format | Scaing Output Displa
Data type
Type: Task: Default >
NoValue / Defaultvalue
Value: |+FullScale > Deactivate NoValue and use Default Value
Channel type
Input: Output: v
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4.3 Counter Input IP=TRONIK

4.3 Counter Input

ww = oo e I B %

Signals Acquisitior View Data mar

| 8 £ B i 8
NI N & SE AR
NI DAQmx System Check Adjust pDatect Initisize Disp
V01.01.00 MName Active Uit Phys Min
Narme z W u
» o 1ctr0 - v
4 Nl UsB-6501-1 [% 3
6 Digital 2
©
eneral Format  Scaling  Display | Counter-1jO
Mode:
Cyde source:
Active edge:
Counting direction:
Initial value: 0

9

The 6501 module supports only software timed counter. The software timed counter uses a software timer,
which is based on the sampling rate, for periodically sampling the data. Because of working with a period
duration, only sampling rates are accepted, which can be converted into an even period duration
(1000/Sampling rate).

The other boards like USB-6221 or 6229 can have external cycle sources which will be discussed in then next
chapters.
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5 Devices BNC 6221 and BMC 6229 IP=TRONIK

5 Devices BNC 6221 and BMC 6229

5.1 Device overview

The channels in IPEmotion are grouped in the same structure as on the board. For example the USB BNC
6221 board has the following channels configuration.

» 8 x differential BNC analog inputs (16-bit, 250 kS/s)
» 2 x BNC analog outputs (16-bit, 833 kS/s),

» 8 x BNC Digital Inputs (hardware timed)

» 16 x BNC Digital Inputs

» 2 x BNC 32-bit counters

N BT

System Check Adjust

V01.01.00
2
6221 (BNC) - 1 BE:
- Digital Port1&2 16
K Counter 2
! Analog In 8
Analog Out 2
ﬂ Digital (Hardware-Timed) PortQ 8
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5.2 Analog Inputs IP=TRONIK

5.2 Analog Inputs

2 wm 2o B Ak X

NI DAQm: System Check Adjust pDetect Initialize Displ

Dev1/ai6
Dev1/ai7

V01.01.00 MName Active Unit Phys Min
Name 2 .
Dev1/fai0 v v -10
NI  usB-6221(BNC) - 1 2f[ » v
6 Dot 0 Dev1/ai2 v -10
@®  Counter 0 Dev1fai3 v -10
@ Dev 1fai4 v -10
8 Analog Out 0 Dev1/fais v 10
0  Digital (Mardware-Ti... 0 v
v

Analog input

Circuit type |Differential -
RSE
NRSE

[11]

[

All analog inputs operate with the same sample rate. When it is defined on one channel it is update on all
other channels automatically.

Please note that the maximum sampling rate depends on the ac-
tive channel count. This results per channel from the maximum
sampling rate divided by the channel count. The more input chan-
nels are active, the less sampling rates per channel are possible.

@‘ Information

5.2.1 Analog Input Tab

Using the Analog input tab you can define the Circuit type. The circuit type defines the type of grounding for
the analog input channels. A detailed description can be found in the documentation of the NI DAQmx driver.
5.2.2 Extended Timing Tab

By using the Extended timing tab you can define the following settings:
» Timing type
» Cycle source

» Active edge

Extended timing

Timing type: External i

Cyde source: PFI13 v

Active edge: Rising edge v

[12]

There are two different timing types available: internal and external.

The first type of the internal timing uses the frequency defined as sampling rate for generating the samples.
The cycle generation runs in the device itself.

The second type of the external timing uses the device for generating the samples by using an external cycle.
Please note that the sampling rate of the inputs must correspond to the external cycle for avoiding potential
synchronization problems between the device and IPEmotion.

The cycle source defines the input where the external timing signal is coming from.

The active edge defines the time for generating the samples based on a rising edge or falling edge.
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5.3 Analog Outputs IP=TRONIK

5.3 Analog Outputs

~ 05 oo M K >

Signals v Data ma
I (>
NI N! & 1Y B2 N i’a‘“‘

NI DAQmX System Check Adjust Detect Initialize Display
V01.01.00 Name Active | Unit Phys Min
MName Z ¥ [

Devifaol v v -10
i NI UsB-6221 (EIND{, 1 4 * L

5 Digital 0

®  Counter 0

Y4 Analogln 2

0, Digital (HardwareTi... 0

Extended timing

Timing type: Internal |-

Cyde source:

Active edge:
[13]

All analog inputs operate with the same sample rate. When it is defined on one channel it is udpated on all
other channels automatically.

Please note that the maximum sampling rate depends on the ac-
tive channel count. This results per channel from the maximum
sampling rate divided by the channel count. The more input chan-
nels are active, the less sampling rates per channel are possible.

6 Information

5.3.1 Timing tab sheet

There are two different timing types available: internal and external.

The first type of the internal timing uses the frequency defined as sampling rate for generating the samples.
The cycle generation runs in the device itself.

The second type of the external timing uses the device for generating the samples by using an external cycle.
Please note that the sampling rate must correspond to the external cycle for avoiding potential
synchronization problems between the device and IPEmotion.

» Cycle source The cycle source defines the input with the external timing.

» Active edge The active edge defines the time for generating the samples.
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5.4 Counter Channels

NI DAGQmX System Check  Adjust Detect Initakize Display  Detais CSV-Importer
V01.01.00 MName Active  Unit Phys Min Phys Max Sensor Min Sensor Max | Sampling rate
Mame Z ¥ N
+ Nl usB-6221(BNC) -1 2 Dewlfetrl [1] 4204967295 0 4204967295 1Hz

W ool 0

'8 Anagln 2

&  AnalogOut 0

16 Dioital (HardwareTi... 0

General Fi

Active:

Name:  Devifctr0
Description:
Reference:

‘Sampling rata: 1kHz

[14]

You have generally to distinguish between two different counter types: Whereas the counter of the
“USB-6501" can only be used as a software timed module, the counter of the “USB-6221 (BNC)” can use an
external cycle source and offers therefore various definition possibilities.

The software timed counter uses a software timer, which is based on the sampling rate, for periodically

Each counter channel can use its own sampling rate. The settings are defined on the respective channel itself.
By using the Counter-1/0O tab you can define the following settings:

» Mode

» Cycle source

» Active edge

» Counting direction

» Initial value

» Duty Cycle

General Format Scaling Display | Counter-IfO
Mode: Edge counting b
Cyde source: |PFI3 -
Active edge: Falling edge b
Counting direction: Countup '~

Initial value: 0

Duty cyde: 0,5
[15]
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5.4 Counter Channels IP=TRONIK

5.4.1 Mode (Edge counting / Pulse output)

There are two different modes available: the edge counting and the impulse sequence.

The first mode of the Edge counting is a common event counter. Because of not offering a possible internal
cycle generation, the counter depends on an external timer if it is not used as a software timed counter. This
cycle defines the frequency for generating and storing the samples.

The second mode Creating an impulse sequence uses the counter as an output and an impulse sequence
can be generated. The sampling rate defines the frequency for generating an impulse sequence. The duty
cycle defines the relation between the logical status (Example: A duty cycle of 0.5 corresponds according to
the impulse duration 50% High level and 50% Low level.

The channel type in the Format tab does not have to be changed
separately at changing between the edge counting and the crea-
tion of an impulse sequence because it adapts automatically to
the required status.

e Information

5.4.2 Cycle source

In addition to the use of an external cycle source, you have the ability to define the internal timers of the
analog in- and outputs as external timer for the counter. The corresponding descriptions in the drop-down
menu are ai/SampleClock for the analog inputs timer and ao/SampleClock for the analog outputs. The
internal timer of the analog in- and outputs can only be used as external cycle source if the channels are
active. That means that at least one channel of this type has to be active and the timer was started.

The use of the analog timers at the same time is limited. Maximum four resources for every device can access
the analog timer at the same time. The analog in- and outputs are already included. At using this limitation, it
is not relevant if the timer is one of the analog in- or outputs.

Please note that the sampling rate must correspond to the ex-
ternal cycle for avoiding potential synchronization problems bet-

ween the device and IPEmotion.
0 Information The external cycle source should not be mixed up with the event
’ counter input. The event counter input differs from device type to
device type and can be found in the corresponding device des-

cription.
Active edge The active edge defines the time for generating the samples.
Counting direction The counting direction defines the upward and downward motion
of the event counter.
Initial value The initial value defines the value for starting the counting.
Duty Cycle The duty cycle defines the relation between the logical status (Ex-

ample: A duty cycle of 0.5 corresponds according to the impulse
duration 50% High level and 50% Low level.
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5.5 Hardware timed Digital Inputs / Outputs

~ 1 5 ElEe-a e N A 4

| ® =
\ N! @ o R T O
NI DAQmx System Check Adjust Detect Initialize Display @ Detais
V01.01.00 Mame Active Unit Phys Min Phy
Name > * .
Dev 1fport0fined ' 0 bl
+ NI USB-6221 (BNC) - 1 6 » v
‘D, Digital 0 Dev 1/port0fine2 0 1
@® counter 0 Dev1fport0fiine3 0 1
E Analog In - Dev 1fportDfined 0 1
% Analog Out 2 Dev1/portdfineS 0 1
Dev1fportDflines 0 1
Dev LportDfine7 0 1
enera Extended timing
Timing type: Externa
Cyde source: | ai/SampleClock v
Active edge: Rising edge -
[16]

In contrast to the software timed digital in- and outputs the hardware timed channels can access an external
cycle source. A timing by using the software timer is not possible.
By using the Extended timing tab you can define the following settings:

» Timing type
» Cycle source

» Active edge

5.5.1 Timing type

There are two different timing types available: internal and external.

The first type of the internal timing uses the frequency defined as sampling rate for generating the samples.
The cycle generation runs in the device itself.

The second type of the external timing uses the device for generating the samples by using an external cycle.
Please note that the sampling rate must correspond to the external cycle for avoiding potential
synchronization problems between the device and IPEmotion.

5.5.2 Cycle source

The hardware timed digital channels need an external cycle source because they do not have a timing unit. In
addition to the use of an external cycle source, you have the ability to define the internal timers of the analog
in- and outputs as external timer for the counter. The corresponding descriptions in the drop-down menu are
ai/SampleClock for the analog inputs timer and ao/SampleClock for the analog outputs. The internal timer of
the analog in- and outputs can only be used as external cycle source if the channels are active. That means
that at least one channel of this type has to be active and the timer was started.

The use of the analog timers at the same time is limited. Maximum four resources for every device can access
the analog timer at the same time. The analog in- and outputs are already included. At using this limitation, it
is not relevant if the timer is one of the analog in- or outputs.
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5.5 Hardware timed Digital Inputs / Outputs IP=TRONIK

Please note that the sampling rate must correspond to the ex-
ternal cycle for avoiding potential synchronization problems bet-
o ween the device and IPEmotion.
6 Information The external cycle source should not be mixed up with the event
N counter input. The event counter input differs from device type to
device type and can be found in corresponding device descripti-
on.

5.5.3 Active edge
The active edge defines the time for generating the samples.

» The same sample rate is configured for one channel and is automatically applied to all other digital inputs.
Define the data direction:

» The Format tab defines the channel type as an in- or output. Over this configuration it is defined whether
the channel is operated as an input or output

~ T e L 2 e

Project Signals Acquisit N Data manager Analyss Reporting Scripting

| N R ACH= I
b (
NI Nl & ¥ N & >
NI DAQmX System Check Adjust Detect [Initialize Display  Details CSV-Importer
V01.01.00 Name Active  |Unit Phys Min Phys Max Sensor Min %snr Max | Sampling rate
Name Z ¥ (]
»

+ NI uss-s221(BNC) - 1 6 Devijportdfinel 0 1 0 1 10Hz
1§ Digtal 0 Devi/portd/ine2 0 1 0 1 10Hz
®  counter 0 Devijportdfine3 0 1 0 1 10 Hz
8 andogin 2 Devi/portd/ine4 0 1 0 1 10Hz
% Analog Out 2 Devifportd/ines 0 1 0 1 10Hz

Dev1/portd fines 0 1 0 1 10 Hz
Dev liportdNine? [} 1 0 1 10 Hz
General = Format | Sealing  Output isplay
Data type
Type: Task: |Default v
NoValue [ Defaultvalue
Value: +rullScale v Deactivate NoValue and use Default Value
Channel type
Input: Qutput: v

(171

IPEmotion_Plugin_NI_DAQmx_V01_01_OPETRONIK GmbH & Co. KG ipetronik.com 17/19



6 Explanations for some error messages IP=TRONIK

6 Explanations for some error messages

The following chapter provides information about potential error messages and known behavioural patterns of
the NI DAQmx Plugin.

6.1 Conflict at parallel access to the same resource

Different functions of a device use sometimes the same physical channel. A counter, which is defined as an
output, physically generates for instance its data on a Digital-I/O channel. If the digital channel is defined as
an input and the counter channel as an output, a resource conflict occurs.

You should generally avoid a multiple use of the same physical channels. You can find the respective channel
configuration in the data sheet of the corresponding module

6.2 The sampling rate of the analog inputs too high

The possible selection of the analogue in-/outputs sampling rate depends on the number of active channels
within a module. Please note in general that the maximum sampling rate can only be selected according to
the maximum possible sampling rate divided by the active channel count in the module. “x” indicates the
maximum sampling rate, which can be selected with the current configuration.

A possible solution is to reduce the sample rate or reduce the number of channels.

6.3 General acquisition error or buffer overflow in one x channel

The data storage has been stopped during an acquisition because of missing valid data from the device. This
often results from a buffer overflow but can also have other reasons. A detailed error description can be found
in the send NI error code in the documentation of the NI DAQmx driver.

A possible solution is the selection of a lower sampling rate.

6.4 The sampling rate is invalid.

The used software timer runs with a period duration. For limiting the user in selection the sampling rate as
less as possible, no fixed values are given but any defined sampling rate is checked on validity. Therefore, the
sampling rate must be selected for being converted into a period duration without decimal places.
(Calculation: Period duration = 1000/Sampling rate)

A possible solution is the selection of a new sampling rate.

6.5 Maximum 4 channel can operate as analog cycle source

As already described in the chapters above, maximum four resources can access the internal timer of the
analog channels at the same time, otherwise a resource conflict can result.
A possible solution is the access limitation of the analog channels timer to four.

6.6 The acquisition task for the channel type “x” cannot be started.

Channels are eventually used by several tasks at the same time. You can find a detailed description of this
limitation in the point above “Conflict at parallel access to the same resource”.
A possible solution is the definition of the module and channel settings.

6.7 A synchronization error in the acquisition of channel “x” occurred.

A synchronization error in the acquisition of channel “x” occurred. The sampling rate eventually does not
corresponds to the external timer.

If an external cycle source is used, the sampling rate of the current module/channel has to correspond to the
cycle source frequency. If they are not conform, an asynchrony between the device and IPEmotion results
and the time stamp of the values does not corresponds to the expected times.

A possible solution is the exact customization of the sampling rate to the external cycle.

Author: FOT

IPEmotion_Plugin_NI_DAQmx_V01_01_OPETRONIK GmbH & Co. KG ipetronik.com 18/19



	Important and general information
	Important information
	Safety and Warning instructions

	Terms and conditions
	Legend of used icons
	Support


	PlugIn Overview
	PlugIn description
	PlugIn installation
	NI-DAQmx driver installation

	PlugIn configurtion
	Hardware detection

	Device 6501
	Device Overview
	Digital Inputs / Outputs
	Counter Input

	Devices BNC 6221 and BMC 6229 
	Device overview
	Analog Inputs
	Analog Input Tab
	Extended Timing Tab

	Analog Outputs
	Timing tab sheet

	Counter Channels
	Mode (Edge counting / Pulse output)
	Cycle source

	Hardware timed Digital Inputs / Outputs
	Timing type
	Cycle source
	Active edge


	Explanations for some error messages
	Conflict at parallel access to the same resource
	The sampling rate of the analog inputs too high
	General acquisition error or buffer overflow in one x channel
	The sampling rate is invalid. 
	Maximum 4 channel can operate as analog cycle source 
	The acquisition task for the channel type ``x'' cannot be started. 
	A synchronization error in the acquisition of channel ``x'' occurred. 


